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Preface
Thank you for using the DocuWide 2050/6030/6050/5070 Plot Driver (hereinafter
known as Plot Driver).

This User Guide describes the procedures and precautions involved in installing and
setting up Plot Driver. Refer to the user manuals supplied with the DocuWide 2050/
6030/6050/5070 (hereinafter known as Fuji-Xerox printers) for details on relevant
operations.

The explanations provided in this User Guide assume that the user has a basic
knowledge of operating the computer and network environment in use. Refer to the
manuals supplied with the computer, Windows® related documentation and the manuals
supplied with the network system for details on computer and network operations.
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Using This Guide
Organization

This guide consists of the following chapters.

Chapter 1. Installing Plot Driver
Explains how to install Plot Driver into your computer.

Chapter 2. Printing Setup
Explains how to print using Plot Driver and how to set up the various printing
conditions.

Chapter 3. Environment-Related Precautions and Limitations
Explains the precautions that must be observed for the environment on which Plot
Driver is to be used.

Chapter 4. Uninstalling Plot Driver
Explains how to uninstall (delete) Plot Driver from the system.



  Using This Guide

Conventions
This User Guide uses the following symbols and conventions:

<   > key Indicates the keys on the keyboard.
 Press the <Enter> key.

[   ] Indicates the menus and display items on the screens.
 Select either the [On] or [Off] buttons to display [Job
Name], [Owner], and [Reason] in that order.

"   " Indicates areas of reference within this User Guide.
Also indicates messages.

Refer to "3.2 Print Services".
A message stating "Additional Port Information Required.
The Device could not be identified" appears. 

Indicates important information which you should read.

Indicates additional information on operations or features.

Indicates reference sources.

Indicates examples.
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Chapter Chapter 0  1
Installing Plot Driver Chapter 1  

This chapter explains how to install Plot Driver into your computer.
The method of installing Plot Driver is described separately for each operating
system for which there is no installation tool. Read the section that is relevant to the
OS being used on your computer.
• Windows® XP→ "1.1 Installing Plot Driver (Windows XP)" (page 2)
• Windows® 2000 → "1.2 Installing Plot Driver (Windows 2000)" (page 21)
• Windows NT® 4.0 → "1.3 Installing Plot Driver (Windows NT)" (page 37)
• Windows® 98 → "1.4 Installing Plot Driver (Windows 98/Windows Me)"

(page 46)
• Windows® Me → "1.4 Installing Plot Driver (Windows 98/Windows Me)"

(page 46)

When upgrading Plot Driver, ensure that the older version Plot Driver has
been uninstalled before attempting to install the upgraded version Plot
Driver. Refer to "Chapter 4 Uninstalling Plot Driver" for details on the
procedures for this (page 87).
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1.1 Installing Plot Driver 
(Windows  XP)

This section explains how to install Plot Driver without an installation tool onto Windows
XP computer.
The installation procedure will differ in accordance with the printer's connection status.
Proceed to the section that corresponds with the environment in use.
• When connected to networks with TCP/IP environments via LPRs: Proceed to

the section on "Connecting to a Network via a LPR".
• When using FTP connections: Proceed to the section on "Connecting to a

Network via a LPR".

• When connected to networks via other Windows 2000 and Windows XP
Systems: Proceed to the section on "Connecting to a Network via Other
Windows 2000 and Windows XP" (page 14).

Connecting to a Network via a LPR

1 Click [Start] on the taskbar, then select [Control Panel] > [Printers and Faxes].
The [Printers and Faxes] window appears.

2 Click [Add a printer].

[Add Printer Wizard] appears.

Data are output to a file and then transmitted for printing from the command
prompt with FTP connections.
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3 Click [Next].

4 Select [Local printer attached to this computer] and then click [Next].

Do not select [Automatically detect and install my Plug and Play
printer]. Plug and Play is not supported.
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5 Select [Create a new port], then select [Standard TCP/IP Port] from [Type of
port], and click [Next].

[Add Standard TCP/IP Printer Port Wizard] appears.

6 Click [Next].

If the LPR compatible printer port to be used is already registered, select that
port, click [Next] and go to Step 12.
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7 Enter the printer name or IP address in [Printer Name or IP Address], and then
click [Next].

A message stating "Additional Port Information Required. The device could
not be identified" appears.

8 Select [Custom], and then click [Settings].

The [Configure Standard TCP/IP Port Monitor] dialog box appears.

The [Port Name] will be entered automatically. Change the entry if necessary.
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9 Select [LPR] for [Protocol].
Enter the logical printer name in [Queue Name] on [LPR Settings], check the
[LPR Byte Counting Enabled] check box, and then click [OK].

The screen will return to [Add Standard TCP/IP Printer Port Wizard].

10 Click [Next].

The installation details appear.

Do not check the [SNMP Status Enabled] check box.

Refer to "What are Logical Printers?" (page 79) in "3.2 Network Connections"
for details on logical printer.
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11 Click [Finish].

The dialog box from which to select the printer's manufacturer and printer
name appear.

12 Click [Have Disk].

The [Install From Disk] dialog box appears.

13 Click [Browse].

The [Locate File] dialog box appears.
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14 Select the folder in which Plot Driver is stored, and then click [Open].

The selected folder appears in [Copy manufacturer's files from] in the [Install
From Disk] dialog box.

15 Click [OK].

The screen will return to [Add Printer Wizard].

16 Select the model to be used, and then click [Next].
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17 Enter any required name if the [Printer name] display needs to be changed. Set
whether the printer is to be used as the default printer, and then click [Next].

18 Select whether the printer is to be shared or not with other printers on the
network.
• If the printer is not to be shared, select [Do not share this printer], click

[Next], and then go to 20.
• If the printer is to be shared, select [Share name], enter the name that the

printer is to be shared under, click [Next], and then go to 19.

The name that the printer is to be shared under must be a name that can be
recognized by other printers.
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19 Enter the printer's location and a comment in [Location] and [Comment], and
then click [Next].

20 Select whether to print a test page or not.

21 Click [Next].
The installation details appear.
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22 Click [Finish].

The [Hardware Installation] dialog box appears.

23 Click [Continue Anyway].

Installation will be started.
• Go to Step 24 if [Yes] was selected in Step 20.
• Go to Step 25 if [No] was selected in Step 20.

24 Check the printed test page, and then click [OK].

Installation can be continued without problem.
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25 Check to ascertain that the printer icon has been added to the [Printers and
Faxes] window.

This completes the installation of the Plot Driver.
The method of changing the printer's spool setting for Plot Driver is explained
below.

Setting the Printer's Spool
After completing the installation, change the printer's spool setting in the printer's
[Properties] dialog box. Sufficient free disk space is required to perform this setting. 
Refer to "2.2 Plot Driver Settings" (page 56) when changing the other settings. 

1 Click the printer icon, and then select [Properties] from the [File] menu.
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2 Select the [Advanced] tab and select [Start printing after last page is spooled].
Uncheck the [Enable advanced printing features] check box, and then click
[OK].
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Connecting to a Network via Other Windows 2000 and
Windows XP

Data are output to the printer via other Windows 2000 and Windows XP. It is necessary
to select [Local Printer] on the computer to which the connection has been established
and install Plot Driver beforehand.It is also necessary for the user who installs Plot
Driver to be registered in order to access Windows 2000 and Windows XP. Refer to the
relevant Windows manuals for further details.

1 Click [Start] on the taskbar, then select [Control Panel] > [Printers and Faxes].
The [Printers and Faxes] window appears.

2 Click [Add a printer].

[Add Printer Wizard] appears.
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3 Click [Next].

4 Select [A network printer, or a printer attached to another computer] and then
click [Next].

5 Click [Next].
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6 Select the printer to which the connection is to be established from the list, and
then click [Next].

7 Set whether the printer is to be used as the default printer, and then click
[Next].

The installation details appear.

8 Click [Finish].
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9 Check to ascertain that the printer icon has been added to the [Printers]
window.

This completes the installation of the Plot Driver.
Proceed to the next step to change the printer's spool setting. Refer to "Setting
the Printer's Spool" (page 12) for setting method.
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Installing Additional Plot Driver
If you share a printer with users running other versions of Windows (Windows 98, Me,
NT, and 2000), you can install additional printer drivers on your computer so those users
can connect to your printer without being prompted to install the drivers missing from
their systems.

1 Right-click the printer icon on which sharing is enabled, and then select
[Sharing].

The printer's [Properties] dialog box appears.

2 Click [Additional Drivers] on the [Sharing] tab.

Fuji Xerox has one DocuWide Plot Driver for Windows 2000/XP and one for Windows
98/Me.
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The [Additional Drivers] dialog box appears. 

3 Check the [Intel   Windows 95, 98 and Me] check box, and then click [OK]. 

4 Click [Browse].

The [Locate File] dialog box appears.

5 Specify the location of the driver to be added, and then click [Open].
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6 Click [OK].

The printer's [Properties] dialog box reappears.
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1.2 Installing Plot Driver 
(Windows 2000)

This section explains how to install Plot Driver onto Windows 2000 computers.
The installation procedure will differ in accordance with the printer's connection status.
Proceed to the section that corresponds to the environment in use.
• When connected to networks with TCP/IP environments via LPRs: Proceed to

the section on "Connecting to a Network via a LPR".
• When using FTP connections: Proceed to the section on "Connecting to a

Network via a LPR".

• When connected to networks via other Windows 2000 and Windows XP
systems: Proceed to the section on "Connecting to a Network via Other
Windows 2000 and Windows XP" (page 32).

Connecting to a Network via a LPR

1 Click [Start] on the taskbar, then select [Settings] > [Printers].
 The [Printers] window appears.

2 Double-click [Add Printer].

[Add Printer Wizard] appears.

Data are output to a file and then transmitted for printing from the command
prompt with FTP connections.
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3 Click [Next].

4 Select [Local Printer] and then click [Next].

Do not select [Automatically detect and install my Plug and Play printer].
Plug and Play is not supported.
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5 Select [Create a new port], then select [Standard TCP/IP Port] from [Type],
and click [Next].

[Add Standard TCP/IP Printer Port Wizard] appears.

6 Click [Next].

If the LPR compatible printer port to be used is already registered, select that
port, click [Next] and go to Step 12.
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7 Enter the printer name or IP address in [Printer Name or IP Address], and then
click [Next].

A message stating "Additional Port Information Required. The device could
not be identified" appears. 

8 Select [Custom], and then click [Settings].

The [Configure Standard TCP/IP Port Monitor] dialog box appears.

The [Port Name] will be entered automatically. Change the entry if necessary.
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9 Select [LPR] for [Protocol].
Enter the logical printer name in [Queue Name] on [LPR Settings], check the
[LPR Byte Counting Enabled] check box, and then click [OK].

The screen will return to [Add Standard TCP/IP Printer Port Wizard].

10 Click [Next].

The installation details appear.

Do not check the [SNMP Status Enabled] check box.

Refer to "What are Logical Printers?" (page 79) in "3.2 Network Connections"
for details on logical printer.
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11 Click [Finish].

The dialog box from which to select the printer's manufacturers and printer
name appear.

12 Click [Have Disk].

The [Install From Disk] dialog box appears.

13 Click [Browse].

The [Locate File] dialog box appears.
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14 Select the folder in which Plot Driver is stored, and then click [Open].

The selected folder appears in [Copy manufacturer's files from] in the [Install
From Disk] dialog box.

15 Click [OK].

The screen will return to [Add Printer Wizard].

16 Select the model to be used, and then click [Next].
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17 Enter any required name if [Printer name] needs to be changed. Set whether
the printer is to be used as the default printer, and then click [Next].

18 Select whether the printer is to be shared or not with other computers on the
network.
• If the printer is not to be shared, select [Do not share this printer], click

[Next], and then go to Step 20.
• If the printer is to be shared, select [Share as], enter the name that the printer

is to be shared under, click [Next], and then go to Step 19.

The name that the printer is to be shared under must be a name that can be
recognized by other computers.
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19 Enter the printer's location and a comment in [Location] and [Comment], and
then click [Next].

20 Select whether to print out a test page or not, and then click [Next].

The installation details appear.

21 Click [Finish].

A screen stating [Digital Signature Not Found] appears.
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22 Click [Yes].

Software installation will be started.
• Go to Step 23 if [Yes] was selected in Step 20.
• Go to Step 24 if [No] was selected in Step 20.

23 Check the printed test page, and then click [OK].

24 Check to ascertain that the printer icon has been added to the [Printers]
window.

This completes the installation of Plot Driver
Proceed to the next step to change the printer's spool setting of Plot Driver.

Installation can be continued without problem.
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Setting the Printer’s Spool
After completing the installation, change the printer's spool setting in the printer's
[Properties] dialog box. Sufficient free disk space is required to perform this setting. 
Refer to "2.2 Plot Driver Settings" (page 56) when changing the other settings. 

1 Click the printer icon, and then select [Properties] from the [File] menu.

2 Select the [Advanced] tab and select [Start printing after last page is spooled].
Uncheck the [Enable advanced printing features] checkbox, and then click
[OK].
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Connecting to a Network via Other Windows 2000 and 
Windows XP

Data are output to the printer via other Windows 2000 and Windows XP computer. It is
necessary to select [Local Printer] on the computer to which the connection has been
established and install Plot Driver beforehand. It is also necessary for the user who
installs Plot Driver to be registered in order to access Windows 2000 and Windows XP.
Refer to the relevant Windows manuals for further details.

1 Click [Start] on the taskbar, then select [Settings] > [Printers].
 The [Printers] window appears.

2 Double-click [Add Printer].

[Add Printer Wizard] appears.

3 Click [Next].
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4 Select [Network Printer] and then click [Next].

5 Click [Next].

6 Select the printer to which the connection is to be established from the list, and
then click [Next].
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7 Set whether the printer is to be used as the default printer, and then click
[Next].

The installation details appear.

8 Click [Finish].
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9 Check to ascertain that the printer icon has been added to the [Printers] window.

This completes the installation of the Plot Driver.
Proceed to the next step to change the printer's spool setting. Refer to "Setting
the Printer's Spool" (page 31) for setting method.
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Installing Additional Plot Driver
If you share a printer with users running other versions of Windows (Windows 98, Me,
NT, and XP), you can install additional printer drivers on your computer so those users
can connect to your printer without being prompted to install the drivers missing from
their systems.

Fuji Xerox has one DocuWide Plot Driver for Windows 2000/XP and one for Windows
98/Me.

Refer to "Installing Additional Plot Driver" (page 18).
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1.3 Installing Plot Driver
 (Windows NT)

This section explains how to install Plot Driver onto Windows NT computer.

1 Log into the system as a user belonging to the Administrator group or as an
administrator. 

2 Click [Start] on the taskbar, then select [Settings] > [Printers]. 
The [Printers] window appears.

3 Double-click [Add Printer].

[Add Printer Wizard] appears.

4 Select [My Computer] and then click [Next].
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5 Select the port to which the connection is to be established from [Available
ports], and then click [Add Port]. 

6 Select [LPR Port] and then click [New Port]. 

The [Add LPR compatible printer] dialog box appears.

7 Enter the name or the IP address of the printer which is specified as used in the
network in [Name or address of server providing lpd].

If the LPR compatible printer port to be used is already registered,
select that port without clicking [Add Port]. After clicking [Next], go to
Step 10. 

When [LPR Port] is not displayed, add the “Microsoft TCP/IP Printing”
service. Refer to the relevant Windows manuals for further details. 
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8 Enter the logical printer name in [Name of printer or print queue on that
server] and click [OK].

The screen will return to [Add Printer Wizard].

9 Check to ascertain that the port which is specified in Step 7 and 8 has been
added and selected in [Available ports], and then click [Next]. 

10 Click [Have Disk]. 

The [Install From Disk] dialog box appears.

Refer to " What are Logical Printers?" (page 79) in "3.2 Network
Connections" for details on logical printer.



40 Chapter 1  Installing Plot Driver

11 Click [Browse].

The [Locate File] dialog box appears.

12 Select the folder in which Plot Driver is stored, and then click [Open].

The selected folder appears in [Copy manufacturer’s files from] in the [Install
From Disk] dialog box.

13 Click [OK].

The screen will return to [Add Printer Wizard].

14 Select the model to be used, and then click [Next].
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15 Enter any required name if the [Printer name] display needs to be changed.
Set whether the printer is to be used as the default printer, and then click
[Next].

16 Select whether the printer is to be shared or not with other computers on the
network.
• If the printer is not to be shared, select [Not shared], click [Next], and then

go to Step 18.
• If the printer is to be shared, select [Shared], enter the name in [Share

Name]. Click [Next], and then go to Step 17.

17 Select [Windows 95] for [Select the operating systems of all computers that
will be printing to this printer.] if you install Windows 95/98/Me drivers as
additional drivers. 
You do not necessarily need to install additional drivers. If you install
additional drivers, the driver which is registered here will be installed when
creating the printer in the client computer. Thus, it is efficient where there are
a lot of client computers. 

The name that is entered in [Share Name] must be a name that can be
recognized by other printers.
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Refer to " Installing Additional Plot Driver" (page 45) for using the Windows
2000 or Windows XP printer driver as a substitute driver. 

18 Select whether to print out a test page or not, and then click [Finish].
• Go to Step 19 if [Yes (recommended)] was selected.
• Go to Step 20 if [No] was selected.

19 Check the printed test page, and then click [Yes].

20 Check to ascertain that the printer icon has been added to the [Printers]
window.
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This completes the Plot Driver installation procedure. 
Proceed to the next step to change the printer’s spool setting of Plot Driver. 

Setting the Printer’s Spool
After completing the installation, change the printer’s spool setting in the
printer’s [Properties] dialog box. Sufficient free disk space is required to
perform this setting. 
Refer to "2.2 Plot Driver Settings" (page 56) when changing the other settings. 

1 Click the printer icon, and then select [Properties] from the [File] menu.

 

2 Select the [Scheduling] tab and select [Start printing after last page is spooled]. 
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3 Select the [General] tab and click [Print Processor].

The [Print Processor] dialog box appears. 

4 Check the [Always spool RAW datatype] check box, and then click [OK]. 



451.3  Installing Plot Driver (Windows NT)

Installing Additional Plot Driver
If you share a printer that is connected to Windows NT with users running under
Windows 2000 or Windows XP, you can install the Windows 2000 or XP driver in the
shared printer from the client computer so those users can connect to your printer
without being prompted to install the drivers missing from their systems. When
installing the driver, it is necessary for the user to have an access authority for the shared
printer on the Windows NT computer. 
The installation procedure of the additional Plot Driver is explained as follows.
The driver for Windows XP and Window 2000 is the same, so that either driver can be
installed and used under the respective OS. 

1 Open the shared printer on the Windows NT computer from the client
computer by using Windows Explorer, right-click the desired printer icon, and
then select [Sharing].

The printer’s [Properties] dialog box appears.

2 Click [Additional Drivers] on the [Sharing] tab. 
The [Additional Drivers] dialog box appears. 
Further set up the driver by referring the descriptions on page 19 and after. 

If the following error message is displayed, install the driver in the client
computer, and then install the additional Plot Driver again.
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1.4 Installing Plot Driver
(Windows 98/Windows Me)

This section explains how to install Plot Driver onto Windows 98 and 
Windows Me computers.

1 Click [Start] on the taskbar, then select [Settings] > [Printers].
 The [Printers] window appears.

2 Double-click [Add Printer].

[Add Printer Wizard] appears.

3 Click [Next].



471.4  Installing Plot Driver (Windows 98/Windows Me)

4 Select [Local Printer] and then click [Next].

5 Click [Have Disk].

The [Install From Disk] dialog box appears.

• The TCP/IP Direct Print Utility is available as software for transmitting and 
printing data directly to printers on the network from computers without 
having to go via a server. Contact Customer Support Center for availability 
of the TCP/IP Direct Print Utility.

• Select [Local Printer] when the TCP/IP Direct Print Utility is to be used.
• Select [Network Printer] when connecting to a printer on another computer

via a network.
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6 Click [Browse].

The [Open] dialog box appears.

7 Select the folder in which Plot Driver is stored, and then click [OK].

The selected folder appears in [Copy manufacturer's files from] in the [Install
From Disk] dialog box.

8 Click [OK].

The screen will return to [Add Printer Wizard].

9 Select the model to be used, and then click [Next].
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10 Select the port to which the connection is to be established, and then click
[Next].

11 Enter any required name if [Printer name] needs to be changed. Set whether
the printer is to be used as the default printer, and then click [Next].

If [Available ports] is not displayed when the TCP/IP Direct Print Utility is to
be used, specify [FILE:] as the temporary port.

The system is not able to determine the printer name from the [Port name]
when the TCP/IP Direct Print Utility is to be used, so it is necessary to enter
the port name in [Printer name].
example : FX DocuWide 5070 (plt00t)
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12 Select whether to print out a test page or not.
Test pages cannot be printed if a temporary port has been specified in Step 10
in order to use the TCP/IP Direct Print Utility. In this event, always select
[No].
Select [Yes (recommended)] to print out the test page in all other cases.

13 Click [Finish] to commence installation.
• Go to Step 14 if [Yes (recommended)] was selected in Step 12.
• Go to Step 15 if [No] was selected in Step 12.

14 Check the printed test page, and then click [Yes].

15 Check to ascertain that the printer icon has been added to the [Printers]
window.

This completes the installation of Plot Driver.
Proceed to the next step to change the printer's spool setting of Plot Driver.
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Setting the Printer's Spool
After completing the installation, change the printer's spool setting in the printer's
[Properties] dialog box. Sufficient free disk space is required to perform this setting. 
Refer to "2.2 Plot Driver Settings" (page 56) when changing the other settings. 

1 Click the printer icon, and then select [Properties] from the [File] menu. 

The printer's [Properties] dialog box appears.

2 Click the [Details] tab and click [Spool Settings]. 

The [Spool Settings] dialog box appears.
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3 Select [Start printing after last page is spooled] and then click [OK].
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Printing Setup Chapter 2 

Explains the basic printing operations, and how to set up Plot Driver.
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2.1 Printing

This section explains the basic procedures for printing, using Windows XP for
explanatory purposes.

1 Start up the application and open the document that is to be printed.

2 Click [Print] from the [File] menu.

3 Select the printer to be used from [Name].

Printing procedures will differ depending on the application in use. Refer to the
instruction manuals supplied with the application for details.

The printer name that has been set as the default printer appears in [Name]. If
a different printer is to be used, select the relevant printer name accordingly.
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4 Click [Properties] to display the Plot Driver setup screen.

5 Set up the various parameters for the [Paper] tab, the [Tray/Output] tab, the
[Graphics] tab, and the [Header/Footer] tab.

6 Click [OK].

7 Click [OK] in the printing dialog box to start printing.

• The screen displayed will differ depending on the model.
• An image of the printer will not appears in the case of DocuWide 2050.

Refer to "2.2 Plot Driver Settings" (page 56) for details on the parameters that
can be set for each tab.
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2.2 Plot Driver Settings

This section explains how to set up the Plot Driver parameters using DocuWide 5070 on
Windows XP as an example.

Displaying the Plot Driver Setup Screen
The following two methods are available for displaying the Plot Driver setup screen.
• From the application software. This method is used to temporarily change the printing

conditions.
• From the [Start] menu. This method is used to change the default printing settings and

the default settings for Plot Driver.

Displaying the Plot Driver Setup Screen from the Application Software
Refer to Steps 1 to 4 in "2.1 Printing" (page. 54) for details on displaying the Plot
Driver setup screen from the application software.

Displaying the Plot Driver Setup Screen from the [Start] Menu

1 Click [Start] on the taskbar, then select [Control Panel] > [Printers and Other
Hardware] > [Printers and Faxes].

The [Printers and Faxes] appears.

Log into the system as a user belonging to the Administrator group or as an
administrator when using Windows 2000, Windows XP, and Windws NT 4.0.

Click [Start] on the taskbar, then select [Settings] > [Printers] with Windows
98, Me, 2000 and Windows NT 4.0.
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2 Select the icon for the printer that is to be set up, and then select [Properties]
from the [File] menu.

The Plot Driver setup screen appears.
Click the [Printing Preferences] to display the Plot Driver parameters. Refer to
"Plot Driver Settings" (page 58) for details.

Select [Printing Preferences] from the [File] menu if the default printer
settings are to be changed.
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Plot Driver Settings
The Plot Driver settings are split between several tabs (menus). This section explains the
parameters that can be set up on each of these tabs.

[Paper] Tab
This section explains the parameters available on the [Paper] tab.

Paper Size
Enables the size of the paper that has been specified with the application to be selected
from the drop-down list box.
• All of the paper sizes displayed in the list can be set to either be displayed or not

displayed with the [Edit [Paper/Output Size]] dialog box. Click [Edit [Paper/Output
Size]] on the [Default Settings] tab to display the relevant dialog box.

• Click the [Apply] button to confirm the settings for each tab.
• The following example uses DocuWide 5070 on Windows XP for explanatory

purposes.

Refer to "Edit [Paper/Output Size]" (page 75).
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• For DocuWide 5070 and other printers that do not support the A0 size, specify A0 for
the [Paper Size], and then select [Same as Paper Size] for [Output Size] to print the A0
image as it is.

Output Size
Enables the size of the paper for printing to be selected from the drop-down list box.

• All of the paper sizes displayed in the list can be set to either be displayed or not
displayed with the [Edit [Paper/Output Size]] dialog box. Click the [Edit [Paper/
Output Size]] on the [Default Settings] tab to display the relevant dialog box.

• The image will be automatically enlarged or reduced in accordance with the [Output
Size] setting if a size that is different to the [Paper Size] has been selected.

• The image will be printed on the same size of paper specified with the [Paper Size]
setting if [Same as Paper Size] is selected.

• When [Fit to Image Size] is selected, the image will be output on the specified size of
paper set by the logical printer, in the same paper size series set by [Document Size]. 

Image Area Only
Generates the part of data which actually be needed for printing.
• When [Image Area Only] check box has been set at ON

Creates print data with the data part only.
For example, when 10cmx20cm rectangle is drawn on a A4-sized document, print data
containing only the 10cmx20cm rectangle part is created. 
Generated data is centered and output on the specified size of paper set by [Output
Size] menu.

For DocuWide 5070 and other printers that do not support the A0 size, set
the system so that A0 is not displayed with the [Edit [Paper/Output Size]]
dialog box.

• The [Output Orientation] settings will be disabled if [According to Printer
Settings] is specified.

• Set up the paper group and size/paper mapping for the logical printer with
Print Services on Web or BT-PlotAssistant if [According to Printer
Settings] has been selected.

Refer to "Edit [Paper/Output Size]" (page 75).

 [Fit to Image Size] is active only when [Image Area Only] check box has been set
at ON.
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Refer to the following table chart for output size and output result.

• When [Image Area Only] check box is OFF.
Print data of a whole sheet is created. If the document is A3 size, the print data will
also be A3 size.

Zoom
Enlarges and reduces the image for printing.

• When the [Zoom] check box has been set at ON:
Enables the enlargement and reduction rates to be entered.The image will be enlarged
or reduced in accordance with the specified value, regardless of the combined [Paper
Size] and [Output Paper Size] settings.

• When the [Zoom] check box has been set at OFF:
Disables enlargement and reduction rate entry. The enlargement and reduction rates
automatically calculated from the [Paper Size] and [Output Size] settings appear in
gray.

Copies
Specifies the number of copies to be printed within a range of 1 to 99.

Output Size Output Result

Same as Paper Size Image is centered and output on a specified paper size.

A0 to Long Print A4 Image is output on the specified paper size.

Fit to Image Size Image is centered and output on a specified size series of 
paper. Output paper size is in accordance with the printer 
setting.

According to Printer 
Settings

Transfer the generated data and output in accordance with the 
logical printer setting.

• [2up] and [4up] in [Multi-up] menu cannot be specified.
• [Output Orientation] is automatically set to [Auto] when [Fit to Image Size] is

selected. 
• There is a possibility that the output length is shorter than the specified

synchronized length, because the data is clipped after generating the
image.  

• When [Image Area Only] is specified to the blank page, blank print data is
created on the specified paper size.

• When reduction/enlargement is specified with [Image Area Only], the data is
generated after reduction/enlargement process is completed. 

The position of the margins and the clip point will differ depending on the
application in use.
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Synchronized Cut
Selects the method of specifying the length of long print paper.

• [Auto Length]
Automatically sets the length of long print paper in accordance with the paper size.

• [Custom Length]
Enables the length of long print paper to be entered.

Output Orientation
Selects the orientation in which the paper is to be output.
The roll paper to be used for printing is selected automatically when this parameter is
set.
• The orientation of the output is automatically set in accordance with the [Output Paper

Size] setting when [Auto] is selected.
• Select [Portrait] or [Landscape] if the orientation of the paper is to be changed when

using a folder or other equipment.

Image Orientation
Selects the orientation of the image specified with the application.

Multi-up
Pastes and prints two or four pages of a document onto a single sheet of paper specified
with [Output Size]. This function is known as [Multi-up], assigning two document pages
to one sheet of paper is known as [2 up], and assigning four document pages to one sheet
of paper is known as [4 up].

• The [Media Orientation] menu appears when [4 up] has been selected. This enables the
sequence in which the pages are to be laid out on the paper to be specified as [Portrait]
or [Landscape].

Rotate Image 180 degrees
Rotates the image 180 degrees and then prints it.

Preview
Enables the image size to be checked before printing. Check the [Displays output
preview] check box and click [OK] to display the [Output preview] window. To print the
image after checking its size, click the  (Print) button.

There are cases where the image at the bottom of the paper will be lost if
the data exceeds the possible printing area of the printer. Set up a bottom
margin on the printer if the data exceeds the possible printing area.

2 up
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The following operations can be performed in the [Output preview] window. 
• Print

Enables printing by selecting the [Print] menu or clicking the  button. 
• Zoom

Images can be enlarged or reduced for viewing by using the [Display] menu or
. Scaling can be specified in the range from 10% to 200%. 

• Navigation
For multi-page document, you can turn the page using . 
The current page number is displayed at the bottom right of the window.

• Size display
The current image size is displayed at the bottom right of the window. 

• Canceling the print
To cancel printing, click the [×] button on the title bar or select [Close output preview]
from the [Display] menu and close the [Output preview] window.

For Windows 98/Me, scaling can be specified in the range from 10% to
100%.
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Print to File
If you check the [Print to file] check box, a TIFF file is generated without printing the
document. You can check the [Print to file] check box if you have previously set the
[Print to file setting] on the [Default Settings] tab. 

• The quality of the image displayed in the [Output preview] window differs
from the actual printing result.

• The [Output Orientation], [Rotate Image 180 degrees], or [Header/Footer]
settings are not reflected on the display. 

• The paper sizes that can be displayed in the [Output preview] window are
regular sizes and long print paper of length 1,230 mm or less. If the paper
size is other than these sizes, a message "Cannot display the preview.
Specified [Output size] is larger than the maximum size to be previewed."
appears and the image size is displayed in the bottom right of the window. 

• Under Windows 2000, XP, and Windows NT, if the [Output preview]
window overlaps with the application window used to perform printing,
moving the [Output preview] window will cause the application window to
remain as a white blank. If this happens, exit the [Output preview] window
to properly display the application window. 

• If [File] is specified for the output port or the [Print to file] in the [Print]
dialog box is checked, an unnecessary file with the file name specified in
the [Print to file] dialog box will be generated even if the printing is
canceled in the [Output preview] window. 

• Windows 98/Me has the following limitations. 
• [Preview] cannot be specified together with [Print to file]. 
• [Print to file] in the [Print] dialog box is ignored even if it is selected.
• If [File] is specified for the output port, the [Print to File] dialog box

appears twice. In this case the file name specified in the second dialog
box will be valid.

• Do not check the [Print to file] check box in the [Print] dialog box or
specify [File] for the output port if you have checked [Print to file].
Otherwise, the [Print to File] dialog box will appear and an unnecessary
file will be generated with the file name specified in the dialog, even
though [Print to file] is normally performed. 

• Under Windows 98/Me, [Print to file] cannot be specified together with
[Preview].

Refer to "Print to file setting" (page 73).
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[Tray/Output] Tab
This section explains the parameters available on the [Tray/Output] tab.

Paper Source
Selects the tray from which the paper is to be fed.
• The source tray is selected automatically in accordance with the type and size of the

media when [Auto] is selected.

Media Type
Selects the type of media to be used for printing.
• The printer settings are given priority when [According to Printer Settings] is selected.

This setting is invalid with DocuWide 2050.
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Collate
Selects whether to print by page or by group when multiple copies are to be printed.
• When [Collate] is set at ON

Prints the multiple copies in groups (1, 2, 3 ... 1, 2, 3).

• When [Collate] is set at OFF
Prints the multiple copies by page (1, 1, 1 ... 2, 2, 2... 3,3,3...).

Print by Reverse Order
Prints multi-page documents in the reverse order, with the last page being printed first.

Folder
Selects the method that the finisher is to fold the paper.
• The printer settings are given priority when [According to Printer Settings] is selected.
• This will be displayed even if a folder has not been installed optionally.
• If the Simple Folder has been installed, only single direction folds will be carried out

regardless of the parameter set here.
• Select any parameter other than [Off] when folding has been specified with the

DocuWide 5070 stacker.

This parameter cannot be set if [2 up] or [4 up] has been specified for [Multi-up]
in the [Paper] tab.

The logical printer settings will be enabled when [According to Printer Settings]
has been selected.
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Fold Type
Selects the detailed folding settings.
• The printer settings are given priority when [According to Printer Settings] is selected.
• This will be displayed even if a folder has not been installed optionally.
• Selects the size of the binding margin with [Binding Margin].
• Selects the finished size with [Fold Adjustment].
• Add ticks to [Stack by 90º Rotation] and [Corner Fold] if necessary.

Stacker
Selects the output method for the stacker.
• The printer settings are given priority when [According to Printer Settings] is selected.
• This will be displayed even if a stacker has not been installed optionally.
• Stacked: Outputs the paper to the top bin.
• Size Sorted: Sorts the output paper by width and changes the designated bin accordingly.
• Bin Designated: Specifies the number of the bin to which the paper is to be output with

[Select Bin Designation].

Baler
Selects the method that the finisher is to bale the paper.
• The printer settings are given priority when [According to Printer Settings] is selected.
• This will be displayed even if a baler has not been installed optionally.

Output Destination
Selects the destination of the output paper.
• This setting is enabled when optional Front Output Kit has been installed.
• The printer settings are given priority when [According to Printer Settings] is selected.
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[Graphics] Tab
This section explains the parameters available on the [Graphics] tab.

Resolution
Selects the resolution to be used for printing.

Print Mode
Specify the image processing method when outputting the reduced/enlarged image.
Default value is [High Speed (Text)].

• The default setting for DocuWide 6030, 6050, and 5070 is [600dpi], and [400dpi]
for DocuWide 2050. Normally, use the default settings as they are. 

• If you want to enhance the maximum output length under Windows 98/Me, reduce
the resolution. 

• If a normal output result cannot be obtained depending on the application, you may
be able to obtain a normal output by reducing the resolution.

Menu Description

High Speed (Text) Reduces/enlarges the image size by simple operation of 
decreasing/increasing the line.

High Quality (Photos) Prevents the moire generation.

Drawings Prevents the fine line loss.
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Convert all colors into Black
Prints all characters, drawings, tables and graphs that are anything but black or white in
color in black when a color image is to be printed in monotone. This prevents fine
colored lines from being difficult to see.

Contrast
Adjusts the contrast of photographs.
[Contrast] indicates the level of change in all tones between white and black. The higher
the contrast, the brighter the tone change.
• The contrast is adjusted within a range of –100 to 100 in single increments through key

entry or with the slide bar.
• The results of changes can be checked on the graphic image on the left-hand side.

All areas that have been filled in with the dither process will also be
converted to black.
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[Header/Footer] Tab
This section explains the parameters available on the [Header/Footer] tab.

Position
Selects the position to print the header and footer.
• The parameter set here will be registered in Plot Driver, so the same settings will be

prevalent the next time Plot Driver is started up.

Enter Text
Characters can be typed into the text box when this check box is set at ON. The entered
characters will be printed in the header or footer.
• A maximum of 64 characters, including the date and time, can be entered in the text

box.
• The character string entered in the text box will be registered in Plot Driver, so the

same settings will be prevalent the next time Plot Driver is started up.

Date[yy/MM/dd]
The date of processing by the plotter will be printed in the header or footer if this check
box is set to ON.
• The format is yy/mm/dd.
• The parameter set here will be registered in Plot Driver, so the same settings will be

prevalent the next time Plot Driver is started up.

This is not supported with DocuWide 2050.
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Time[HH:mm]
The time of processing by the plotter will be printed in the header or footer if this check
box is set to ON.
• The format is hh:mm.
• The parameter set here will be registered in Plot Driver, so the same settings will be

prevalent the next time Plot Driver is started up.

Example
Displays an example of how the header or footer will be printed.

The current date and time are displayed in the example, so different data will be
output during actual printing.
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[About] Tab
Displays the version information for the Plot Driver in use.
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[Default Settings] Tab
This section explains the parameters available on the [Default Settings] tab.

Specify Job Owner
Selects the method of specifying the job owner.
• [Use Login Name]

Sets the name of the user who is logged into Windows as the job owner name.
• [Input Owner Name (For Administrator)] 

Enables the job owner name to be input in a text box. A maximum of 31 bytes can be
used for entering the job owner name.

• [Enter Owner Name (For User)] 
Enables the job owner name to be input in a text box. A maximum of 31 bytes can be
used for entering the job owner name.

The [Default Settings] tab is displayed when the Plot Driver setup screen is
started up from the [Start] menu. Refer to the section on "Displaying the Plot
Driver Setup Screen from the [Start] Menu" (page 56) for details on the Plot
Driver setup screen.

[Enter Owner Name (For User)] does not appear in Windows 98.
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Job Parameter Settings
Sets whether to control output from Plot Driver or not.
• The printing data will be output in the TIFF format when [Off] is selected. This

function facilitates to output the print data to file.
• The following parameters cannot be set when [Off] is selected:

Print to file setting
Specifies the [Print to file] settings on the [Paper] tab in the [Document Properties]
dialog box that appears by clicking the [Properties] in the [Print] dialog box. 
Click [Print to file setting] to display the [Print to file setting] dialog box. 

The following settings can be specified in the [Print to file setting] dialog box. 
• [Folder]

Specify the location where the file is to be saved by entering up to 128 single-byte
characters (or up to 64 double-byte characters), or by using [Browse] to select the
location. 
Specifying the [Folder] enables the [Print to file] check box to be checked.

• [File name setting]
Select [Use application setting] or [Specify file name] for the file name setting.

Tab Parameter

[Paper] Tab Output Orientation

Copies

Rotate Image 180 degrees

[Tray/Output] Tab All parameters in the tab.

[Header/Footer] Tab All parameters in the tab.

Under Windows 98/Me, [FileDir] is displayed for the file name if you press
[Browse] to display the [Browse for Folder] dialog box. Simply ignore the file
name and specify the folder.
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If you select [Use application setting], a file name is specified based on the document
file name notified by the application to the printer driver. 

By selecting [Specify file name], you can freely specify the [File name]. 
• [File name]

Up to 32 single-byte characters (16 double-byte characters) can be entered for the file
name. For Windows 98, up to 8 single-byte characters (4 double-byte characters) can be
entered. 

• [How to process existing file name] 
Sets up the procedures in the event that a file with the same name exists in the folder.
You can select one of 3 options: [Open confirmation dialog], [Overwrite the existing
file], [Add a number to the file name and save it]. If you select [Open confirmation
dialog], the confirmation message "The same name file already exists. Do you want to
overwrite it?" appears. If you select [Overwrite the existing file], no confirmation
message appears and the file is overwritten and saved. If you select [Add a number to the
file name and save it], a hyphen and 3-digit serial number is suffixed. (Example: "aaa-
001")

• [Add controller command]
This option can be selected when [Job Parameter Settings] on the [Default Settings] tab
is set at [On]. If [No] is selected, the file identifier will be ".tif". If [Yes] is selected, the
file identifier will be ".pjl", in which case, the created file cannot be edited with image
editing software. This file cannot be output to other printers.

The document file name that is notified by the application may differ from the
actual file name (which is displayed on the title bar). The maximum number of
characters for the file name that is notified by the application differs depending
on the operating system: For Windows NT/2000/XP, up to 32 single-byte
characters (16 double-byte characters), and for Windows 98/Me, up to 8
single-byte characters (4 double-byte characters). The excess characters are
automatically truncated. If a file name includes both the single-byte and the
double-byte characters, the file name may be illegal. 

If you select [Add a number to the file name and save it], and the number
exceeds the maximum of "-999", a message appears and the process is
aborted. When the number of characters including the 3-digit number exceeds
the limit, the excess characters are truncated from the end of the file name
and the file is saved with a hyphen and the 3-digit serial number.
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Edit [Paper/Output Size]
Edits the paper size types displayed in [Paper Size] and [Output Size] on the [Paper] tab.
• Click [Edit [Paper/Output Size]] to display the relevant dialog box.

• The [Edit [Paper/Output Size]] dialog box enables the selection of the size for which
the display or non-display setting is to be changed, and specifies whether [Display on
[Paper/Output Size]] is to be set at [Yes] or [No].

• The A4 size is always set for display, so is consequently not displayed on the [Edit
[Paper/Output Size]] dialog box.
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Chapter Chapter 0  3
Environment-Related 

Precautions and Limitations Chapter 3  

This chapter explains the precautions that must be observed for the environment on
which Plot Driver is to be used.
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3.1 Operating Environment

Versions that support printer firmware

Computer Environment

Model Version

DW2050 All versions

DW6050/DW6030 All versions

DW5070 All versions

Computer Intel Pentium III processor 850 MHz or higher,
256MB or more of memory.

Supported OS Windows 98, Windows 98 SE English version

Windows Me English version

Windows NT Workstation Version 4.0 English version
(Service Pack 6a is recommended.)

Windows NT Server Version 4.0 English version
(Service Pack 6a is recommended.)

Windows 2000 English version
(Service Pack 2 or higher) 

Windows XP English version
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3.2 Network Connections

What are Logical Printers?
Logical printers are one hundred different types of virtual printer settings stored in the
printer. Each of these one hundred settings can be assigned different printer names.

Adding the Protocol and the Service (Windows NT 4.0)
You need to install the TCP/IP protocol and the "Microsoft TCP/IP Printing" on the
Windows NT 4.0 computer beforehand if you output to the Fuji Xerox printers via a
network. 

(1) Installing the protocol
You need to install the TCP/IP protocol on the Windows NT 4.0 computer beforehand if
you output to the Fuji Xerox printers via a network. 
Open [Network] in the control panel and click [Add] in the [Protocols] tab to display the
[Select Network Protocol] dialog box. Select [TCP/IP Protocol] from the displayed list
and click [OK]. The TCP/IP protocol is added. After adding the TCP/IP protocol, set up
the details such as the IP address in the [Properties] dialog box.

(2) Adding the service
You need to enable lpr in order to print out to the Fuji Xerox printers from the Windows
NT 4.0 computer via a network. 
Open [Network] in the control panel and click [Add] in the [Services] tab to add
[Microsoft TCP/IP Printing]. 

[plt00t] to [plt99t]
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3.3 Windows 98/Me Network Connections

Fuji Xerox printers use the TCP/IP protocol, and ftp and lpr for transmission purposes.
Windows 98 and Me assume that Fuji Xerox printers are UNIX network printers capable
of transmitting with ftp and lpr.
Although Windows 98 and Me are already equipped with networks (*1) for this, Plot
Driver cannot be connected directly to the Unix network printer port. Owing to this, if
the system consists only of Windows 98 or Me, it is not possible to print directly onto
Unix network printers from normal applications simply by installing Plot Driver.
However, printing directly to UNIX network printers from Windows 98 and Me
applications is possible if the printing job is transmitted via the Netware Server,
Windows 2000, or Windows NT Workstation/Server print spoolers, or UNIX network
software is installed into Windows 98 and Me.
The following are detailed examples of printing from Fuji Xerox printers with the use of
these two methods.

Connection Method
This section explains the "(1) Connecting Via UNIX Print Spoolers" and "(2) Installing
UNIX Network Software on Windows 98 and Me" connection methods.

*1 The TCP/IP, NWLink and NETBEUI protocols are included, but lpr is not
installed as a component. However, ftp is installed so that files can be
transmitted to UNIX systems.
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(1) Connecting Via UNIX Print Spoolers

Computers installed with Windows NT Workstation or Windows NT Server (hereinafter
known as Windows NT) function as printing gateways to UNIX network printers for
Windows 98 and Me client computers.
The method of setting this up is explained below.

Windows NT 4.0 Setup
TCP/IP protocol installation
In order to communicate with the Fuji Xerox printers in which the TCP/IP
protocol is installed, the TCP/IP must be installed as a protocol in the computer.
Check the installed network software by selecting [Control Panel] > [Network]. If
the TCP/IP protocol is not installed, install it.
Install lpr in the network component
In order to transmit the printing data to the Fuji Xerox printers, the setup enabling
to use lpr on the Windows NT is required. If lpr cannot be used, install the
network software by selecting [Control Panel] > [Network], select TCP/IP
network print suppurt, and update it. 
Creating shared printers to transmit printing jobs via lpr
It is necessary to create (*2) a shared printer that acts as the printer's lpr port for
the connection in order to connect Fuji Xerox printers that are connected to a
network to Windows 98 and Me computers.

Case1: When the network consists of computers with Windows NT 4.0
Workstation or with Windows NT 4.0 Server

*2 In order to access shared printers on Windows NT from Windows 98 and Me, it is
necessary for the user to have an access authority for “Printing” or higher.
Check the access authority level in [Print manager] >[Security] of the Windows NT
computer if it is not possible to establish a connection with the shared printer from
Windows 98 and Me.
Consult your Windows NT system administrator for details on access authority levels.

Select [Shared] for Step 16 "Select whether the printer is to be shared or
not with other computers on the network." (page 41) in "1.3 Installing Plot
Driver (Windows NT)" and set [Share Name] under which the printer is to
be shared. 

Refer to "1.3 Installing Plot Driver (Windows NT)" (page 37) for creating the
shared printer. 
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Server service confirmation
In order for Windows NT to provide Windows 98 and Me client computers with
the printing service, the Server service must be executed. The default setting on
Windows NT is to execute this automatically. Check to ascertain that the [Server]
setting is set to the [Execute] status by selecting [Control Panel] > [Service] menu.

Windows 98 and Me Setup
Protocol installation
It is necessary to install the protocol that is installed in Windows NT into
Windows 98 and Me computers in order to enable these two systems to
communicate.
Either of the TCP/IP, NWLink, and NETBEUI protocols are acceptable for this.

Microsoft Network Client installation
It is necessary to ensure that the [Microsoft Network Client] is installed in order
for Windows 98 and Me computers to use a shared printer on Windows NT.
Follow the steps shown below: [Control Panel] > [Network] > [Add] > [Client] >
[Microsoft] > [Microsoft Network Client].

Printer creation
When installing Plot Driver, specify the name of the shared printer that resides in
the Windows NT computer on the network (the name of the shared printer that
transmits with lpr to the Fuji Xerox printer created previously in "  Windows NT
4.0 Setup") as the queue name to which a connection is to be established.

Computers installed with Windows 2000 (hereinafter known as Windows 2000) function
as printing gateways to UNIX network printers for Windows 98 and Me client computers.
The method of setting this up is explained below.

Case2: When Windows 2000 is available
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Windows 2000 Setup
Creating shared printers to retransmit printing jobs with lpr:
It is necessary to create (*3) a shared printer that acts as the printer's lpr port for
the connection in order to connect Fuji Xerox printers that are connected to a
network to Windows 98 and Me computers.

Server service confirmation
It is necessary to execute the server service to enable Windows 2000 to provide
printing services for Windows 98 and Me client computers. The default setting on
Windows 2000 is to execute this automatically, but confirm that the [Server]
setting on the [Control Panel] > [Service] menu is set to the [Execute] status.

Windows 98 and Me Setup
Protocol installation
It is necessary to install the protocol that is installed in Windows 2000 into
Windows 98 and Me computers in order to enable these two systems to
communicate. Either of the TCP/IP, NWLink and NETBEUI protocols are
acceptable for this.

Microsoft Network Client installation
It is necessary to ensure that the [Microsoft Network Client] is installed in order
for Windows 98 and Me computers to use a shared printer on Windows 2000.  
Follow the steps shown below: [Control Panel] > [Network] > [Add] > [Client] >
[Microsoft] > [Microsoft Network Client].

Printer creation
When installing Plot Driver, specify the name of the shared printer that resides in
the Windows 2000 computer on the network (the name of the shared printer that
transmits with lpr to the Fuji Xerox printer created previously in "  Windows
2000 Setup") as the queue name to which a connection is to be established.

*3 In order to access shared printers on Windows 2000 from Windows 98 and Me,
it is necessary for the user to have an access authority for [Printing] or higher.
Check the access authority level if it is not possible to establish a connection
with the shared printer from Windows 98 and Me. Consult your Windows 2000
system manager for details on access authority levels.

Select [Share as] in procedure 18 ("Select whether the printer is to be
shared or not with other computers on the network.") (Page 28) in section
"1.2 Installing Plot Driver (Windows 2000)", and then set the name under
which the printer is to be shared.

Refer to "1.2 Installing Plot Driver (Windows 2000)" (page 21) for details on
creating shared printers.
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(2) Installing UNIX Network Software on Windows 98 and Me
Of the network software marketed by various software manufacturers, the software that
is to be used must integrate UNIX with personal computers, must allow the use of lpr,
and must enable Plot Driver to be connected to the lpr port.
The network software with which Fuji Xerox has confirmed connection capabilities is as
follows:
• TCP/IP Direct Print Utility for Windows 98/Me (manufactured by Fuji Xerox).

Supplementary Information
Fuji Xerox printers support ftp to enable data files to be transmitted from Windows 98
and Me computers to our printers. It is consequently possible to enter the ftp command
in the MS-DOS prompt and transfer files after the Plot Driver destination has been
specified as [FILE], and the plot data has generated a file on the disk. However, note that
data cannot be printed directly from applications in this case, and the ftp command
operations must always be carried out.
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3.4 Precautions When Setting Up the 
Printer Parameters

• The maximum printable lengths are listed below:
• Windows 98/Me: 2,070 mm at 400 dpi, and 1,386 mm at 600 dpi.
• Windows NT/2000/XP: 3,276 mm (with applications equipped with paper outlines)

or 15,000 mm (with applications not equipped with paper outlines.)

Refer to the Release Note with the Plot Driver for other cautions and restrictions.
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Chapter Chapter 0  4
Uninstalling Plot Driver Chapter 4  

This chapter explains how to uninstall (delete) Plot Driver from the system.

When upgrading Plot Driver, ensure that the older version has been
uninstalled before attempting to install the upgraded version.
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4.1 Uninstallation Procedure

You can uninstall Plot Driver by double-clicking "UnInst.exe" in the [Uninstall Tool]
folder which was used to install the Driver.

This section explains how to uninstall Plot Driver, assuming Windows XP.

1 Open the folder that you used to install Plot Driver and double-click the
"UnInst.exe" file in the [Uninstall Tool] folder.

2 Specify the driver to be deleted, and then click [Delete].

The [Confirmation of Driver (s) To Be Deleted] dialog box appears.

The driver file will not be completely removed if you delete (uninstall)
the driver from Control Panel. To ensure all driver files are completely
removed, use the provided "UnInst.exe" tool.
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3 Click [Yes].

The driver is deleted and a completion message appears.

4 Click [OK].

This completes the Plot Driver uninstallation procedure. Reboot the computer.
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